AWS 900 PRO TooOLS TUTORIAL

PRO TooLs AND THE AWS 900

INTRODUCTION

Pro Tools provides two complimentary ways of viewing a session, by use of a mixing console and an editor. The
mixing console display, know as the Mix Window displays tracks as channel strips with controls for inserts, sends,
input and output assignment, volume, panning, record enable, automation mode and solo/mute. The editor, know
as the Edit Window displays a timeline of audio, as well as MIDI date and mixer automation for recording, editing

and arranging tracks.

The AWS 900 acts a control surface for the Mix and Edit Windows in Pro Tools, helping control features such as
fader control, plug-in selection and I/O assignment, plus much much more with ease. This guide will help explain
some of the main features in Pro Tools and how the AWS 900 can be used to control these features.
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Figure 1 - AWS 900 with DAW controller sections highlighted

PRO ToOLS MIX WINDOW
In the Mix Window, tracks appear as channel strips with controls for inserts, sends, input and output assignment,

volume, panning, record enable, automation mode and solo/mute.
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Figure 2 - Mix Window in Pro Tools
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PrRO TooLs EDIT WINDOW

The Edit Window provides a timeline display of audio, as well as MIDI data and mixer automation for recording,
editing and arranging tracks. As with the Mix Window, each track has controls for record enable, solo, mute and
automation mode.
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Figure 3 - Edit Window in Pro Tools

TRANSPORT CONTROLS

The transport window can be set to show basic transport controls, counters and MIDI controls. The counters in
the transport window mirror the Location Indicators at the top of the Edit window (see Figure 3).
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Figure 4 - Transport Window and corresponding AWS 900 controls
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RTZ (Return-To-Zero) — Returns the playback cursor to the Session start time.

END (Go-To-End) — Moves the playback cursor to the end of the Session.
ONLINE - Puts the DAW on line for synchronization.
LOOP - Toggles Loop mode on/off (hold down CTRL to select Loop Record mode).

Q PUNCH - Toggles Quickpunch recording status on/off for your DAW.

REWIND - Holding down this button will rewind the DAW (increment depends upon Display mode).

+ FAST FORWARD - Holding down this button will fast forward the DAW (increment depends upon display
mode)

» STOP - Stops playback or recording
* PLAY — Commences playback from the current cursor position or at Start time.

To begin playing from a specific point within a track:

» Select Operations > Scrolling Options > No Auto Scrolling

* Make sure to select Operations > Link Edit and Timeline Selection

» With the Selector tool (see Figure 5), click in the track where you want playback to begin.
 Click play to start.

To make the track display and the edit cursor to follow playback:
» Select Operations > Scrolling Options > Page Scrolling During Playback

» Choose Setups > Preferences. In the Operation page of the Preferences dialog, select the option for “Timelink
Insertion Follows Playback,” the click Done

» Make sure to select Operations > Link Edit and Timeline Selection

With the Selector tool, click where you want playback to begin.

Click play to start. The playback cursor scrolls across the Edit window, indicating the current playback position.

RECORD - Engages DAW recording for currently armed tracks

The IN and OUT buttons are used to mark In and Out edit points when in play, or record.
* The PRE and POST buttons are used to activate or de-activate the pre or post-roll functions for your DAW.

EDIT TOOLS

Pro Tools has editing controls displayed at the top of the Edit Window. The AWS 900 displays these controls on
the TFT screen in the centre section of the console, simply by pressing the relative soft keys under the TFT

screen. Explanations of the edit controls are below.

Select EdTs (Edit Tools) with the
soft keys undey the TFT screen
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Figure 5 - Edit Tools in the Pro Tools Edit Window with corresponding AWS 900 controls.
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* ZOOM - use the zoomer tool to zoom in and out around a particular areas within a track.

* TRIM — the trimmer tool provides region, note, and data trimming functions — this allows you to quickly shorten
or expand a region.

+ SELECT - use to set where playback begins by clicking anywhere on the track.
* GRAB - use to grab a section to move/edit.
* SCRUB - the scrubber lets you “scrub” up to two tracks of audio in the Edit Window.

* PENCIL - the pencil tool allows you to destructively “re-draw” audio waveform data and can be useful for
creating and editing MIDI data.

* SMART - with the smart tool you can instantly access the Selector, grabber and Trimmer, and you can also
perform fades and crossfades (depends where the mouse is positioned on the track).

EDIT MODES

Within Pro Tools you can select Shuffle, Spot, Slip and Grid Mode:

Select EdMo (Edit Modes) with the
soft keys under the TFT screen

A EdTs |EdMo Fkys SSL
[AuMo|
] sip | spot | Gria -

Figure 6 - Edit Modes in the Pro Tools Edit Window with corresponding AWS 900 controls.

* SHUFFLE - In shuffle mode, you can move regions freely within a track or to other tracks, but their movement
is constrained by other regions. That is, if you place several regions in a track, they automatically snap to each
other. You can then “shuffle” their order, but you cannot separate them from each other and you cannot make
them overlap as in slop mode. However, if there is silence between existing regions and the regions are shuffled,
the silence in maintained, not moved.

+ SPOT - Use Spot mode to place regions at precise locations. In Spot mode you can specify a frame location
or a location based on any of the other time formats, capture an incoming Time Code address, or use a region's
time stamps as reference points for spotting. This can be particularly useful when performing post production
tasks around SMPTE frame locations.

« SLIP - In Slip Mode, regions can be moved freely within a track or to other tracks. In this mode, it is possible
to place a region so that there is space between it and other regions in the track. When the track is played back,
this space is silent. It is also possible to move a region so that it overlaps or completely covers another region.
* GRID - In Grid mode, moving any region snaps the region start to Grid boundaries. If a region's start point falls
between beats, and the Grid is set to 14 notes, dragging the region will snap its start time to the nearest 14 note
( the current absolute Grid value).

CREATE A MIDI TRACK FOR TOTAL ReEcaALL™
To create a MIDI track go to: File>New Track

Select a MIDI track as show in figure 7 below.

New Tracks

|
| Create 1 new  (Mano 8 | ¢ Audio Track B) in [samples 8 &
I Master Fader |
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1

Figure 7 - Window to create a new MIDI track in Pro Tools.
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Set the Input and Output to AWS 900 port 4, this is the MIDI port that is routed to the Total Recall.

VAl
AWS1, Port 1 - channel-1
AWS2, Port 1 »
AWS3, Port 1 > |
Predefined » ‘

Figure 8 - MIDI channel with AWS 900 Total Recall Port Selected

Record arm the track by pressing the RDY button in the Master Control Panel of the AWS 900 and select the MIDI
track using the SEL button on the appropriate channel strip. A red REC light will flash on the channel's meter on
the console, and in Pro Tools.

Figure 10 - RDY - Record Ready button on the Master Control Panel of the AWS 900

Press the record button and the play button on the console transport controls to set the MIDI track to record.
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Figure 11 - Transport Controller on the AWS 900

In the Total Recall page on the console press the save button in lower row of controls — the save display will light
up yellow on the TFT screen. The save will have finished when the save display returns to grey and you can press

the stop button on the transport controls.

Select 551, then TR (Total Recall) with the
soft keys under the TFT screen

Misc § TR SsL

Sel JChan JCmFbj DynB § StRt § Copy § Save | Load

Figure 12 - Total Recall controls

To recall the TR, disarm the record enable, thensimply press the load button in the lower row of controls and play
back the MIDI track (by pressing the play button on the transport controls). As soon as the AWS 900 detects the
start of valid data it will delete all of the current setups and replace them with the stored ones from the MIDI track.

SETTING UP AN AUX TRACK WITH AN INSERT
To create an Aux track go to: File > New Track
Select a stereo Aux track as show in figure 13 below.

New Tracks
Audin Track

ceate TAT  new  [5wreo 15) ERTIDTEEE 5) v (s B &
| Magter Fader [ .
[ Cancel ) m‘,

| DI Track

Figure 13 - Window to create a new Aux track in Pro Tools.

Set the input to Bus 1 and 2.

To add an insert using the console press the EDIT button on the master control panel on the AWS 900 and press
the SEL on the desired channel, in this case the AUX track we have just created. This will highlight the EDIT
display on the console's meters.

Figure 14 - Channel Meter on AWS 900 Console with EDIT highlighted
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Figure 15 - Edit button on Master Control Panel of the AWS 900 console

The TFT screen will now display the AUX channel and allows you to select the desired Plug-in using the rotary
encoders underneath the TFT screen. Simply press ASSIGN, turn the rotary encoder until you get the desired
Plug-in and press ASSIGN again. Then press the INSERT button and you will see all the controls available to use
and can change these parameters with the rotary encoders.

|

Figure 16 - Pro Tools channel strip with insert

Highlighted in blue to show
which paramenters are being
controlled by the rotary plug-in
encoder53n the AWS 900

-¥ikd
Figure 17 - Pro Tools D-Verb Plug-in

NOTE: You may find that with Pro Tools 6.4 and later versions of software, you cannot select a Plug-in via the
console if you are working on channels 9 or above. If you need to add a Plug-in to tracks 9 or above, you can do
one of 2 things:

1) You can use the mouse in the Pro Tools Mix Window, click on an insert of the required channel and select the
Plug-in you require. These can then be edited via the rotary encoders on the console as with tracks 1 — 8.

AWS 900 TuToRiaLs
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2) You can bank the channels 9+ to the first 8 channels by using the individual banking switches. Simply press
CHANNEL button so it is highlighted (see Figure 18), and press the LEFT arrow to bank the desired channels
across to 1 - 8 on the AWS 900.

Channel button to ndi\/iduallyr
Left Arrow bank a channel on the AWS 900

Figure 18 - Channel banking in the Master Control Panel of the AWS 900 console.

ADDING A SEND ON A CHANNEL OUT TO THE AUX WE JUST CREATED!
We can use the console to add a send to channel and it is simple!
Press the ASSIGN button and then the SEND button on the master control panel (see below).

Figure 19 - Assign and Send controls, and Push to Flip button on the Master Control Panel of the AWS 900
console

Here you can chose Send's A — E simply by turning the main rotary encoder (labeled Push to Flip in Figure 19)
On the desired channel, turn the rotary encoder until it is at bus 1 — 2, so it will be routed to the AUX track we just
created with the reverb on it and click to assign.

Now the rotary encoder on the channel strip can be used to change the send level. If you want to use the main
fader to change the level, simply click the large rotary encoder in the centre section called “Push to Flip”.
Set to busses

1and 2
[EEET
| 1 +—~Pan Control
Fader_.§| -—Mute
et Pre/Post

Figure 20 - Send controls on Pro Tools channel strip

The ASSIGN button can also be used to assign the Inputs and Outputs of a channel, without having to use the
mouse. Simply press the ASSIGN button, and then either the INPUT or OUTPUT button in the Master Control
Panel. Then, as with the sends, move the rotary encoder of the desired channel to the Input/Output you require
and press in the encoder to save.

If you would like to change all of the channels to the same output, hold down the OPTION key in the Master
Control Panel, change one rotary encoder to the correct Input/Output, press in the encoder and all will change to
the same setting.

If you would like to increment the channels, say for example to set all outputs to 1-24 so each channel has its
own analogue path for mixing, press and hold the OPTION and ALT buttons on the Master Control Panel, and
move the rotary encoder of channel 1 to Output 1. Press the encoder to save, and all channels will then increment
from 1-24
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AUTOMATION - DAW

Here we can select what controls are automated on the console's TFT screen — they are highlighted yellow when
active.

These settings can also be changed in Pro Tools via the drop-down menu: Window > Show Automation

aukn faumo | Eats JEamo | ster | Frys | Eait |ssL |

Fader| Pan | Pigin| Mute | send] Mute ] |

]

Select AuEn (Automation auto arm:
Enable) with the soft keys
below the TFT screen
Automation Enables in manual write to:
Pro Tools - Window - Show e e [=1]
Automation auto write on stop!
[+ ][]
sart all end

Figure 21 - Automation Enable controls in the TFT screen of the AWS 900, and corresponding Pro Tools controls

The Automation Modes can be selected via the console's TFT screen. Simply press and hold the desired mode
button (TFT screen) and press the automation enable button on the correct channel, next to the fader.

Automation Enable

Button \l—
These lights will flash /.-v a
depending on which [ g 0

mode has been selected

Figure 22 - Automation mode switch next to the AWS 900 faders
These modes can be selected by the drop-down menu on the channel strip in the Mix window of Pro Tools.

Modes) using the soft keys
under the TFT screen

menu in the Pro Tools Mix

Modes in the drop-down __—1
]
Window J

BB R EmE

Figure 23 - Automation Mode controls on the TFT screen of the AWS 900, and corresponding drop-down menu
in Pro Tools

Automation Modes —some more information

¢ Auto Off — this mode will turn off all automation for all automatable parameters.

» Auto Read — this mode plays back the automation that has been written.

* Auto Write — this mode writes automation from the time playback starts to the time it stops, erasing any
previously written automation for the duration of the automation pass. When you have finished writing it
automatically switched to Auto Touch mode so that you don't accidentally write over what you have just done!
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* Auto Touch - this mode writes automation only while a fader or switch is touched or clicked with the mouse
or console. When the fader is released, the writing of automation stops and the fader returns to any previously
automated position, at a rate determined by the AutoMatch and Touch Timeout settings (see Pro Tools manual
for more!) Auto Latch — this mode works in the same way as Auto Touch mode, writing automation only if touch
or move a control. However, unlike Auto Touch, writing of automation continues until you stop playback. This
mode is particularly useful for automating pan controls and plug-ins since it does not time out and revert to its
previous position when you release a control

* Trim Mode (only TDM systems) — this mode works in combination with the other Automation modes and is
useful when you want to preserve all of your volume automation moves, but need to make levels a bit louder or
softer to balance the mix. When editing automation in Trim mode, fader moves write relative rather than absolute
values. The existing automation data is changed by the amount of increase or decrease indicated by the faders.

To automate plug-ins you have to click on the Auto button on the plug-in and the select what you want to automate
from the menu (simply select the control you want to automate and press Add — repeat for all parameters you

want to automate, then press OK).
(&}

& P as:
T E R E TS [Guto sare]

Click on the ‘auto’ button at
the top of the Plug-in window
to add parameters to be
automated
Figure 24 - Auto button on Plug-in window
Select the parameter you Click Add
want to automate
7 Plug-In Autonfation

(input
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( Cancel )

Press OK when all
parameters added

Figure 25 - Plug-in Automation window in Pro Tools

When you have selected the required parameters for automation they will be highlighted in RED when writing
automation and GREEN when reading automation.

NAVIGATION, ZOOM AND SELECTION MODES

The Motion Control panel has a section with four arrow keys and a ZOOM/SEL button that toggles the selection
of three available modes: Navigation Edit, Zoom and Select.

Navigation Edit (Neither Zoom or Select lit)

This mode acts as a powerful region selector for your DAW.

Zoom Mode (Both Zoom and Select lit)

The arrow keys now become horizontal and vertical zoom controls for the edit/arrange window on your DAW.
Selection Mode (Both Zoom and Select flashing)
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In this mode the arrow keys provide a way to create and edit selections within your DAW program without having
to use a mouse.

Zoom/Sel button
for toggling between
Mavigation, Zoom and

Selection mode

[@=]
ﬂCJH%)I—ICJFP

Figure 26 - Navigation, zoom and selection controls on the Motion Control Panel of the AWS 900 console
An example of using the above modes to grab a section of audio from a track:

Select the track you wish to edit by pressing the SEL button on the master Control Panel and on the desired
channel to edit.

>

Figure 27 - Select button on the Master Control Panel of the AWS 900 console

Cursor will “blink”

at the IN value

3 w

Section of audio

we want to edit
Figure 28 - Track we will edit - highlighted area in Pro Tools

To move the cursor to the beginning of the required section simply put into navigation mode and press the right
arrow so it will move to the next audio region (you can then hold down SHIFT to select area, but this can take a

lot longer):
The cursor has now jumped to
he region boundary that we
want to edit

Figure 29 - Cursor moved to correct starting point when in Navigation Mode

Switch into selection mode to select the area. This is simple. Just hold down the RIGHT arrow key and rotate the

centre jog wheel to select the entire region.
Area highlighted in
Selection Mode

Jog Wheel on Motion
Control Panel

Figure 30 - Area now highlighted when in Selection Mode and the jog wheel
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To make sure the end is accurate you can zoom in! Simply go into zoom mode and press the RIGHT arrow key
to zoom in. Note, this will zoom in at the beginning of the selection. To go to the end press the RIGHT arrow key
on the gqwerty keyboard.

Area has no audio

at the end where
the region has been
selected too far
Figure 31 - End of the track zoomed in using Zoom Mode
Then go back into selection mode and move to the end of the region.

At the end now!

Figure 32 - Selection to the end of the desired area when in Selection Mode

Once you have selected the region you can use the edit tools displayed on the TFT screen to copy/paste etc. the

area you have highlighted.

Select Edit using the soft keys
under the TFT screen

Figure 33 - Edit Tools selected by the soft keys on the AWS 900 console

Zoom sizes can be stored simply by pressing SHIFT and a number on the numeric keypad — you can store up to
5. To recall simply press OPTION and the relevant number.

GROUP

To group a selection of tracks, for example the drum section, press the SEL button in the Master Control Panel
(see Figure 27), hold SHIFT and select the desired tracks.

Press CREATE in the Status Groups menu (StGr) displayed on the TFT screen, name your group and press

ENTER on the numeric keypad or on the gwerty keyboard.
Press StGr (Status Groups)
using the soft keys under
the TFT screen on the
AWS 900

Auto [Monit [Phase’ (Creat JSuspe] I

™
AuEn JAuMo | EdTs JEdMo | StGr | Fkys | Edit | SSL I
roup| [

\Click Creat to create
a new group

Figure 34 - Status Groups on the AWS 900 console

To see which channels have groups hold down the Group key above and groups will be displayed with the
relevant letter in the scribble strip

The Suspe(nd) key in this menu (see Figure 34) will suspend the automation.

You can also see which channels have automation by pressing and holding the Auto key in this menu. The
scribble strips will display what automation mode the channels are in.
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By holding down the Monit(or) key you can see the monitor status of all 24 focused channels on the fader scribble
strip. The labeling is as follows:

» Auto Auto input mode

* Inpt Input mode only

* Aux Auxiliary input channel
MIDI MIDI channe

* Mstr Master Fader

NOTE: Phase button not implemented.

aws 500 Turonacs [
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AWS 900 MIDI INTERFACE SETUP

INTRODUCTION TO MIDI

MIDI (Musical Instrument Digital Interface) was conceived as a mechanism for transmitting and receiving large
amounts of time-sensitive information over a simple send and receive path. Originally conceived for live
performance, It has now become one of the most robust standards in use for the interconnection of systems in
recording studios, audio and video production and composition environments.

A MIDI data byte is transmitted in 320us. All AWS control data is transmitted or received as 'Controller Data' which
consists of two MIDI data bytes or a transmit/receive time of 640us per a message. This is orders of magnitude
faster than the control update rates used by console automation systems which fall in the frame (40/33.33ms) to
1/4 frame (10/8.33ms) region.

The AWS 900 uses an exclusive MIDI IN/OUT pair for each group of 8 channels. This dedicates the full bandwidth
of a 16 channel MIDI interface to carry AWS control and status data to and from the DAW.

The use of MIDI also allows greater cable lengths between the console and the DAW, USB can be used at a
maximum length of 5m, whereas MIDI can run up to lengths of 15m.

Figure 1 - AWS 900 at Solid State Logic Headquarters

CONNECTING A MIDI INTERFACE TO YOUR AWS 900 AND DAW

Physical connection between the AWS 900 console and your DAW system is very simple. The console
communicates with the DAW via three MIDI ports located on the rear of the console (four if Total Recall installed):
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Figure 2 - MIDI connections from the MIDI Interface to the AWS 900
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These MIDI ports should be connected to your DAW MIDI interface unit, and require three available ports (where
one single port includes an IN and OUT socket). To connect one port, the output of the MIDI interface unit port 1
should connect to the MIDI 1 input port of the AWS 900. Also, the MIDI output of the AWS 900 port 1 should
connect to the input of your MIDI interface unit port 1. Repeat this for the other two ports, using the diagram above
as a guide. The fourth port is used for Total Recall if installed.

Figure 3 - Emagic AMTS8

Lnitor8
Figure 4 - Emagic Unitor 8

MO TN — == MIN GUT——

WISTIAIEE, somimyn

Figure 5 - MOTU MicroLite

Figure 6 - MOTU MIDI Express 128

We have had a number of instances when MIDI communication has failed or been unreliable when using the
DigiDesign MIDI IO unit. This is because the MIDI IO unit only supplies +4.2V on its MIDI OUT connectors, rather
than the +5V required by the MIDI hardware specification. For this reason SSL advises against the use of the
DigiDesign MIDI IO interface with the AWS 900 unless it has been modified to provide +5V on its MIDI outputs.

SETUP WITH PRO TOOLS

Before MIDI is connected and configured between Pro Tools and the AWS 900 console, the AWS 900 TFT screen
will display the following in the top right corner of the screen:

Figure 7 - TFT screen on AWS 900

Now go into the following menus in Pro Tools: Setups > Edit MIDI studio setup...

When the MIDI setup is opened in Pro Tools it will scan for MIDI interfaces. When found it will appear with each
of its ports numbered.

_ 1 Fi 3 4 5 b ' 8 )
[wAT [w[A] [w]A] [w[a] [w]A] [W]a] [w]a] [W]4]

Figure 8 - MIDI Interface display in Pro Tools

Click on Add Device at the top of the window. Here a default keyboard image will appear which can then be
connected to the MIDI interface.
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new external device

Figure 9 - New External Device display in Pro Tools

Double click on the device to enter the properties of the device.

Bt] 8 AWS 900 Properties

| Device Name AWS 900

e

Manufacturer SSL

Model AWS 900

) wu

More Informatio

( Revert ) ( A

oy

CLIOK HERE TO CHODOSE
CLICKE HERE TO BET PORTS
Aws 900 IMAGE

Figure 10 - Properties of the AWS 900 displayed in Pro Tools
Enter the following:

Name: AWS 900

Manufacturer: Solid State Logic

Model: AWS 900

If you would like to add an image of the AWS 900 please visit http://www.solid-state-
logic.com/midiinterface/midiinterface4.php and save it in the following place in your Library folder for the system:

/Library/Audio/MIDI Devices/Generic/Images/

Figure 11 - AWS 900 icon for Pro Tools

Next click on the More Properties button and add 3 more ports giving 4 in total (the final port for Total Recall if
installed).

aws 500 Turonacs [N
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Figure 12 - More Properties displayed in Pro Tools under proberties_of the device

Connect the device to the MIDI interface using the mouse by clicking on the small arrows and drag to the MIDI
interface arrows — continue for all ins and outs for the 4 ports.

Figure 13 - MIDI connections displayed in Pro Tools
Now go into the following menu: Setup > Peripherals
Select the following in the table to enable the MIDI interface:

Type Receive From Send To #Ch's

#1 [l [%) [awsoooprer |5 [ awssooprr (3] (8
#2 [ [Hu [+) [ awssooprez 4 [ Awssoopriz |4 [ &
#3 [l [ru [+) [ awssooprtz |4 [ Awssoopriz |4 [ &
#4 [ [ none ) [ none % [ none =N

Figure 14 - HUI Setup in Pro Tools
On the AWS 900 desk, the TFT screen will now display the following:
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WiLL MOT APREAR IF TATAL

HETALLED

RECALL MOT

WILL STILL AFPEAR WITH A
X

IMETALLED

IF TOTAL RECALL MOT

Figure 15 - TFT screen on AWS 900
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ROUTING TUTORIAL

INTRODUCTION

The AWS 900 has a large range of routing possibilities, allowing for many quick and easy recording and
monitoring solutions. The AWS 900 can act as a split desk, monitor mixes can be setup with the press of a switch
and with 2 stereo busses, simple drop ins can be created. With the EFX key, multiple headphone mixes can be
made and many more FX units can be added to your music. Sub grouping and 5.1 mixing is made easy with the
mono busses.

In this tutorial we explore all the routing options for the AWS 900 in simple step by step instructions, making it
even easier to get the most out of your AWS 900 console.

DIRECT OuUTSs

Each channel on the console has a direct output. Depending on configuration, this can be connected straight to
the input of the DAW tracks. This allows for simple one to one recording from the AWS 900 to the DAW.

With nothing on the console pressed, the direct out will go post fader to the DAW.

2

2 m e a

45,
—_—
30
Source AWS 900 Level Control DAW
via Fader

Figure 1 - Direct Output Path - Post Fader

By pressing the Direct Pre/EFX switch, the Direct Out will record Pre Fader level, giving a monitor mix,
independent of what is being recorded to the DAW.

Pre Fader switch
Source AWS 900 (level control DAW
by gain pot)

Figure 2 - Direct Output Path - Pre Fader

By pressing the Direct Pre/EFX switch and the EFX switch on Cue Stereo A (or Cue Stereo B, FX1, FX2, FX3 or
FX4), the level to the DAW is controlled via the Stereo Cue A pot in the channel strip (or Cue Stereo B, FX1, FX2,
FX3 or FX4). This allows independent gain control of the DAW input without changing the monitor mix or gain pot.

Pre fader switch
+

—
Cue Stereo A
EFX switch

Source AWS 900 Level Control via DAW
Cue Stereo A pot

Figure 3 - Direct Output Path - EFX

aws 500 Turonacs [N



AWS 900 ROUTING TUTORIAL

STEREO BUSSES

The AWS 900 console has 2 main stereo busses; the Record Bus and the Mix Bus. Each channel on the console
can be routed to these stereo busses, and easily changed via 2 switches on the fader labeled REC and MIX.
Each stereo bus has its own master fader, and assignable switches for the stereo compressor, dynamics, an extra
10dB of gain, and insert switches. Note that all are post channel fader.

Y .
Source AWS 900 Record or Post Channel
Mix switch Fader

Master Stereo Fader Assignment switches for
Stereo Busses

Figure 4 - Stereo Bus Path

The AWS 900 can be used as a spilt desk, by assigning Mic/Instrument inputs to the record bus, and then
anything that is being monitored; synths/keyboards or a stereo mix from the DAW for example, can be routed to

the Mix Bus. To hear both at the same time, simply press the sum switch in the monitoring options list.

Stereo Mix
From DAW

Synths/Keyboards
Mic/Instrument elc.
Inputs

Figure 5 - Using the Console as a Split Desk
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By using the Stereo Busses, we can apply a quick and easy way to punch into record. Simply connect the left
and right outputs of the Record Bus to inputs 1 and 2 of the DAW. Assign all channels to inputs 1 and 2 (see
diagram for how to apply to all at once). Then switch all channels to Mix bus (this can be done by one press of a
button in the Miscellaneous options in the monitoring section of the AWS 900. When a track needs to be put into
record, record arm the track, and switch it to the Record Bus. Any of the channels switched into record will then
automatically record onto tracks 1 and 2 of the DAW. To hear both the mix and record bus, press the sum button
on the monitoring options.

Connect the Left and Right
Outputs of the REC bus to
Inputs 1 and 2 on the DAW

Turn D-pot
to equal
Inputs 1 - 2

ASSIGN|—=] INPUT OPTION
DAW Inputs
Remember to Record Arm the tracks 1 and 2

Figure 6 - Stereo Busses - Quick Record
8 MONDO TRACK BUSSES

Each channel on the AWS 900 can access 8 mono track busses, located at the top of the channel strip. Each bus
has its own master level control, and AFL switch. The bus feeds can be post fader, pre fader, and post pan.

=

R T

8

Blikis &N

Source AWS 900 Post Channel 8 Mono Track
Fader Busses

Figure 7 - Mono Busses - Post Fader (nothing switched on)

Source AWS 900 Pre Fader 8 Mono Track
Switch Busses

Figure 8 - Mono Busses - Pre Fader (Pre switch pressed)
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(I
»" s a3

=— @

tih s els

Source AWS 900 Post Pan Post Post Pan
Switch Channel
Fader

TTI] o

8 Mono Track
Busses
Figure 9 - Mono Busses - Post Pan (automatically Post Fader - Pan switch pressed)

5.1 mixes can be created by sending mono track bus outputs 1-6 to feed a 6 track recorder. To monitor track
busses 1-6, enter External A in the Monitoring section (EXTA), and press the fifth option. If your 5.1 monitors are
connected as recommended by your AWS 900 manual (set as Dolby standard), track busses 1-6 will equate to
Left, Right, Centre LFE, Left Surround and Right Surround, as shown in Figure 10.

Left Channel Right Channel Centre Channel Subwoofer

Left Surround Channel Right Surrodnd Channel

Figure 10 - Mono Busses - 5.1 Mix

Sub groups can be made to create stereo mixes, which can then have channel dynamics or main stereo dynamics
added.

Inputs 1 - 8 -t

Kick
Snare
Hihat
Overhead left
Overhead right
Tom left
Tom right
Tom floor

‘11T

11T

Source AWS 900 Post Mono Track
Channel Busses 1
Fader and 2

[| tnputs 9 - 10

DAW
(or FX units/tape
machine etc.)

Figure 11 - Mono Busses - Sub Groups

AWS 900
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CuUE STEREO SENDS

Each channel on the AWS 900 can access 2 Cue Stereo Sends.The "Cue St" Pot controls the level to either of
the sends and this is switched between Cue A (default) or Cue B (Cue B Switch). Each Cue Send has its own
master level control, master pan and AFL switch. They can be routed either pre fader (ideal for headphone mixes)
or post fader by pressing the post switch.

Cue Stereo A/B Foldback Foldback
Master Level Controls
Control

Figure 12 - Cue Stereo Sends - Pre fader

Cue Stereo A/B

Post Cue Stereo A/B FX unit
Fader Master Level
Control Control

Figure 13 - Cue Stereo Sends - Post fader

FX SENDS

Each channel on the AWS 900 can access 4 mono FX sends. There are 2 "FX" pots on each channel strip - FX1
and FX 2. The "FX 1" Pot controls the level to either FX 1 or FX 3 sends and this is switched between FX 1
(default) or FX 3 (FX 3 Switch). The "FX 2" Pot controls the level to either FX 2 or FX 4 sends and this is switched
between FX 2 (default) or FX 4 (FX 4 Switch). Each FX send has its own master level control and AFL switch. All
are post fader.
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Source AWS 900 FX 1/2/3/4

Post FX 1/2/3/4 FX unit
Fader Master Level
Control Control

Figure 14 - FX Sends - always Post Fader
EFX SwITCH
On each channel of the AWS 900 there is an EFX switch for the Cue Stereo Sends/ FX's 1-4 and Direct Out. The

EFX switch allows for added headphone mixes, extra FX units, and as explained on the Direct Out section, an
independent gain control from the monitor mix.

By pressing the EFX button on Cue Stereo A for example (applies to all), the signal is re-routed to the 8 mono
busses. This means that the Cue Stereo A bus has no signal anymore. Figures 15 and 16 give a visual
representation of this.

Source AWS 900 Cue Stereo A/B,
FX1/2/3/4

)
1‘ 'r
<—

Master Controls Headphones/FX units

Figure 15 - Cue Stereos/FX sends without any EFX switches pressed.
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Press EFX
switch

Source AWS 900 Cue Stereo A/B,
FX1/2/3/4

Master Controls Headphones/FX units

This signal is re-routed to the Mono Busses

8 Mono Track FX Units/
Busses Headphone
Systems

Figure 16 - Cue Stereos/FX sends with an EFX switch pressed.
EFX SwiTCcH

By using the Cue Stereo A/B EFX button, the signal can be sent to the 8 mono track busses, which can be
connected to a headphone system. This will allow addition headphone mixes to be made. Figure 17 shows an
example setup of this configuration (next page).

Extra FX units can be added by using the EFX button with the FX sends and routed via the 8 mono busses. Figure
18 gives an show a flow diagram with added FX units and the combination of switches to achieve the desired FX.

AWS 900 TuToRiaLs
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Press EFX
switch

/i

T
Mono B Headphone
System
MaaT)

Track Busses 1+2
Track Busses 3+4
Track Busses 5+6
Track Busses 748

/

Post 8 ses
Fader
Control
‘|‘ 'i_"
| -

N

12345678910111213 141516

I
i i Keyboards
Drum mix Guitars Y Vacals

Figure 17 - Cue Stereos with EFX switches pressed for Headphone System Mixes

Press EFX

DAW Output AWS 900 FX 1/2/3/4

Up to 4 more stereo
FX on FX busses

Post 8 Mono Busses
Fader
Control
Channel

1 2 3 4 5 6 7 8
| )% [
FX1 FX2 FX1 FX2 FX1 FX1 FX1 FX1

+ + + + + +

A I I EoEa R
3

FX4 EFX EFX EFX

+

+ + o+
E
Bus 1 Bus 2 B

Lo

Reverb Reverb Reverb Reverb Echo Echo Echo  Echo
1 2 3 4 5 [ 7 8

Figure 18 - FX sends with an EFX switch pressed - added FX units
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MONITORING TUTORIAL
MONITORING CONTROL PANEL

The AWS 900 has a large range of monitoring possibilities and combinations. Figure 1 shows the Monitoring
Control Panel.

Click for
monitor options

Click to select monitors
(5.1 A monitors if
nothing selected)

Figure 1 - Monitoring Control Panel
5.1 MONITORING

In Table 1, we have all the combinations of 5.1 monitors on the AWS 900 and which buttons to press to achieve
these combinations.

Buttons Left Centre Right Iéittround :Lgr::tund LFE
Mothing Pressed L L L L L L
ALT 5.1 B B B B B B
ALT 5.1 and LRA A A A B B B
ALT 5.1 and SRA B B B A A B
ALT 5.1 and LRA and SRA |2 A A A A B
ALT 5.1 and AZB B B B B B A
ALT 5.1 and LRA and AZE [|& A A B B A
ALT 5.1 and SRA and A2B B B B A A A

Table 1 - 5.1 Monitoring

STEREDO MONITORING
In Table 2, we have all the combinations of the stereo minis on the AWS 900 and which buttons to press to
achieve these combinations.

Buttons Left Right k::nuasgeedrjzrnfass
Mini A A A

Mini B B B

Mini A& and BMH A A A

Mini B and BMHN B B A

Mini & and BMM and BMA A A B

Mini B and BMN and BME B B B

Table 2 - Stereo Monitoring
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AFL/ MONITOR
Ed EQ Ed & X 3

Insert PFL to Surround LCR Calibration Bass
encoder/ minis on A on A Setup Management
decoder _ options

Adjust Adjust Adjust Next 80Hz Low Bass Low zmxﬂ
Left Right Centre Window Pass Filter Management Frequency Window
Monitor Monitor Monitor _ On Gain

Adjust Adjust Adjust Low Bass Return to Keeps  Uses ALT 5.1 Uses ALT 5.1 Return to
Left Right LFE Frequency Management Monitor 51A Subwoofer  Subwoofer Monitor
Surround Surround Monitor Gain Adjustment ~ Options Subwoofer for Bass for Bass Options
Monitor Monitor Menu Management Management Menu
| with Mini As with Mini Bs l

Figure 2 shows all the acronyms of the monitoring buttons with a tree diagram of the various monitoring menus.

AWS 900 MONITORING TUTORIAL
MONITORING ACRONYMS
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AWS 900 AWSOMATION SETUP
INTRODUCTION

AWSomation is a fully featured automation package, developed from SSL’s renowned G and K Series Ultimation
systems, but with an enhanced feature set designed specifically for the AWS 900. AWSomation utilizes the classic
SSL look and feel, familiar to thousands of engineers worldwide, to add dynamic fader and cut automation to the
console. MTC (MIDI Time Code) serves as the mix timeline reference together with support for MMC (MIDI
Machine Control) locate commands to follow non-play speed positional changes from the DAW. Use of SysEx
(System Exclusive) MIDI data transfer allows mixes to be saved to a workstation or SysEx librarian, retaining the
integrity of the project data.

Key Features

. Frame-accurate fader and cut automation data

. Moving and non-moving fader modes

. Fader Links - group fader control

. Mix Pass history

. AutoTakeover

. Variable fader glide times

. Fader safe mode

. Fader update status lock

. Match and Play cut automation updates

. Mixes and Fader Links are saved as Sys-Ex MIDI data together with the Total Recall Data

In this tutorial we will go though the AWSomation system step by step, giving useful examples and quick guides
to getting you started! We hope that you find them useful!
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PRO TooLs SETUP

To set up timecode generation go to Windows>Show Session Setup, or press the Status key in the centre section
of the console.

Sample Rate: 48 kHz Aipdio Fanmat; SO Session Start: T 00000
iz Depth: 24 -bit Mag<-»PC: Nt Enforced Incoming Time:  00:00:00:00
Clack Saurce: [ SYNC /0 ] Timecodsfame: (25
Synnem Dl --- Fader Gain: +6 dB FeersFramas Rate: | 34 E
¥ SYNC Setup & Time Code Offsets
SYNC Setup Session Stam Offsets
Clock Reterence: | Video Reference 19 — MMC 00:00-00:00)
Positions! Reference: | LTC &) Unk@ - 3-Pin
Video Feamat: | PAL &) —  Sync 0000:00:00
2 vso @

Locked @ Speed L D

¥ Time Code Semings

CEnErator Freewheel Pull Up) Dowe
_!.;alnq SYNE T} Nome Audiio Rate Pulll Up/Down
L T—
B ware To Pet B & frames S
(AWSHOUSYSELTC ) Jam Syme “Wone =
Time Code Reader Offser 0 samples

Figure 1 - Session Setup Window in Pro Tools

Select Time Code Settings at the bottom left-hand corner of the screen, tick the MTC To Port and select the port
on the MIDI interface that is connected to AWS 900 port 4 in MIDI In (for further information about setting MIDI,
please check out the MIDI tutorial here).

Note: It is expedient to make a note of the timecode standard that was used for a particular AWS 900 mixing
project. AWSomation automatically detects the timecode standard from the incoming MTC messages. It will quite
happily attempt to play out stored mix data to any incoming timecode used to originally reference the mix.

To set up the MMC locates go to Setups>Peripherals>Machine Control.

Peripherals

— Synchronmration - Machine Contred-| MIDI Controllers | Ethernet Controllers | Mic Preamps ——

MIDI Machine Corntrol

Send to L

& Enable [ Aows 500, SysEcatC B 327 |
Prerolk. 90  frames
9-Pin Serial B
Fort Machine Type

—! Emable

Prerall: 150 frames
TRequires SYNC 10 Using Video Clock Reference)
9-Pin Remate
Port Machine Type

L] Emabde | Mone - VW75 : L Chase LTC

{. Cancel “] m

Figure 2 - Machine Control Window > Peripherals in Pro Tools

Enable MIDI Machine Control and select the Port on the MIDI Interface that is connected to AWS 900 port 4 MIDI
In. Leave the ID as 127, as this sends to all connected devices.
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To to ensure that MMC locate messages are transmitted correctly from Pro Tools, go to

Setups>Preferences>Machine Control and tick Machine Chases Memory Location and Machine Follows Edit
Insertion/Scrub.

(Ongiay  Operason | ldeng  Actomation | Proceuing | WIDY D MschewComtrel)

Bpmoty Mods

Machine Controd
B Mhathiss Chanes Mesmory Logation
4 Machines Fabows Lt Imertion, Sars
— Muching Cuen IndeBigenily

Punch ia Frama Offsee: O |
Purch Out frame Offaee: 0
Dukay Adver Pay Command: | 0 |
L igmonn Track Arming
U St Serve Lodh Bt AL Play (Tamura Ssppern

[ $ecp At Shuttle Speed Zers
Dy Befoere Lovching Ta LTC )

e

Figure 3 - Machine Control Window > Preferences in Pro Tools

When mixing with the AWS 900 it is advisable to enable Timeline Insertion Follows Playback and Edit Insertion
Follows Scrub/Shuttle in the Setups>Preferences>Operation menu. This ensures that a rollback operation will
occur following a locate or rewind operation in Pro Tools. If the first options are not enabled, then Pro Tools does
not send a locate command following a Stop command even though the console counter will show the position
that Play last occurred from, and where Play will resume from. The AWSomation rollback will then occur when
the system is returnedto play which can be disconcerting. Enabling these options ensures that rollbacks occur

prior to entering Play but at the expense of defeating the Pro Tools feature of automatically returning to the last
play position following the Stop command.

A Prelieres

Diapdey COREBGAY [Sting  Automston | Procosing | MIDU | Maching Contrel

& Timeleae it ion Folln Prybet

¥ £da innernion Fotlmr Sciubbhatle

B Sencls Bt To "ol

— Audio During Faat Formard /Remind

= Comwert imporind “way” filgy tg AESD 1 /Brogdca ey
B Ausio Track RecordLock

= Teamspen Recondlack

Remene keypad Made
) Clannic

) Trasapen

) i

Eirling Opiticns

1) Reened Online AL Time Code (ar ADAT) Lack
T Racoad Oniling Af b grtionTeleczion

Cotbam Wutile Lok Speed. B0 %
Callbration Relerence Level - 16 o
Aune Regeen Tade i Oua Lemgch o maet

Es

¥ Latch Revord Enabie Bumons

9 Link Min And B8t Cooup Enasled

¥ Link Recosd A May Faders

) Wi F20 Kay T Wit e Nt

! Austomatically Copy Fils on mpart

9 Dnable Input” When Dhsanming Track (in “Fiogs
= MAyre Recond- Armad Trahs Wisle Sopeed

Akt
& Enabie Session File Auta Eaciup
Keegr | 10 | maont rronst backups
Backup evtry. S | msuins

Dpen nded Record Alocstion

) Use AN Avslable Space

) it T wieatrs

Sola Lakch

& Latch

) Memantary

7 %08 iCancels Previows Sala)

Back (forward Amourt Ao1o0p | Kars Beats .j.g

Ebm—s)

Figure 4 - Operation Window > Preferences in Pro Tools
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Note:

The AWS 900 uses the same MIDI port for saving and loading mixes and reviewing MTC. Ensure that any MIDI
tracks containing SysEx data are muted while mixing, as SysEx data will interfere with MTC transmissions.

The time taken to transmit each AWSomation Mix Pass varies depending on how much automation data each
Mix Pass contains. An unlimited number of AWSomation Mixes can be stored in this way.

Large mixes can generate SysEx dumps of more than one minute, which some DAWSs are incapable of recording.
Please ensure your DAW can cope with large SysEx dumps.

START AUTOMATING!

The AWSomation package has many functions and abilities, but here we will just show you how to quickly and
easily do your first AWSomation mix!

On the TFT screen, press the SSL soft key.

=1 T I I I I

Figure 5 - Soft Key Menu - SSL

Now press the Auto soft key.

Misc TR Auto Lnks S5L

Figure 6 - Soft Key Menu - Auto (AWSomation)

To start a new Mix, press the List Mix soft key. Highlighted yellow will be New Mix. Press the left rotary encoder
to select a New Mix.
23 Mix Enabled A T T T

New Mix 5 TAl
Highlighted F

Press to show B
Mix Passes | SavelLoad

I I Y I A

Figure 7 - Mix Passes screen
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Follow the onscreen directions, making sure you have located to the beginning of the track you want to automate.
Then press Execute.

00:02:12:23 Mix Enabled

Press Execute after

R ) T -
beginning of track _| | - i
to be automated

m ﬂ [ Auto | os ] ]| - E

Figure 8 - Execute screen

Now its time to automate! Each of the Red LEDs will light up near the fader, and this means you are in absolute
mode. The screen displayed will show MIX RUNNING and has all 24 faders and the stereo buss faders shown.
Simply press Play and away you go, moving your faders throughout the track. When you have finished press Stop
and locate the the beginning of the track. The screen will now display MIX REVIEW. To end the Mix Pass,
effectively saving your automation, press the End soft key.

':F‘|nn|1| I |||||| |'

Stereo
24 channel Mix and Rec
faders faders

v = M - |
Mix Pass
mm---

Trim Moff § TLock i Snap AT Match Play

Figure 9 - Automation screen

Your screen will now show your new automation mix as Mix Pass 1. And that is it, one automated track!
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SAVING AND LOADING AWSOMATION MIXES

It is easy to Save and Load your AWSomation mixes. Below is how to save and load with Pro Tools, but the
principleswill be the same for other DAWSs. The tutorial is the similar for saving Total Recall data, as shown in the

Pro Tools tutorial (click here to view)

MIDI Track in Pro Tools:
To create a MIDI track go to: File - New Track
Select a MIDI track as show in figure 10 below.

Mew Tracks

+ Audio Track
Aux Input
Master Fader

Create 1 new [ Mono g

5
(+

( Cancel ) (& Create)

Figure 10 - Window to create a new MIDI track in Pro Tools.

Set the Input and Output to AWS 900 port 4 (this is the MIDI port that is routed to the Total Recall as well - see

MIDI controller tutorial here to set ports).

v All

AWS1, Port 1 - channel-1
AWS2, Port 1

AWS3, Port 1

AWS TR, Port 1

v A4V Y

Predefined

MIDI
Track

Figure 11 - MIDI channel with AWS 900 Total Recall Port Selected

Record arm the track by pressing the RDY button in the Master Control Panel of the AWS 900 and select the MIDI
track using the SEL button on the appropriate channel strip. A red REC light will flash on the channel’'s meter on

the console, and in Pro Tools.
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AwE11

ST 1

Flashing red

indicators

Figure 13 - RDY - Record Ready button on the Master Control Panel of the AWS 900

Press the record button and the play button on the console transport controls to set the MIDI track to record.

— —
I I it I I -
- =

Figure 14 - Transport Controller on the AWS 900

In the List Mix menu, in AWSomation, on the console press the Save/Load button - then press the Save button
which will light up yellow on the TFT screen. The save will have finished when the save display returns to grey
and you can press the stop button on the transport controls.

AWS 900 TuToRiaLs
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00:02:12:23 Mix Enabled A e

MNew Mix
Mix Pass 1
Mix Pass 2 >> 1

Prass ~ M Press
to Save | M to Load

—
m-m----

Figure 15 - List Mix controls

To recall the AWSomation Mix Pass, disarm the record enable, then simply press the Load button in the List Mix
menu and play back the MIDI track (by pressing the play button on the transport controls). As soon as the AWS
900 detects the start of valid data it will delete all of the current mix passes and replace them with the stored ones
from the MIDI track.

JOIN AND REVISE

At any time during Mix Review, the Join key can be used to switch all channels originally in write at the last
rollback point back to write at the levels or state they were at the rollback point. This is useful, for example, when
balancing a chorus level. When you have achieved this balance, you can rollback, hit Join and the levels will
punch in at the balance set before rollback, and all channels immediately return to write. The Revise key has a
similar action except that all channels in write at the Rollback point are returned to write at their current mix
position. This is useful if you have been automating a section, but made a small mistake. Just rollback prior to
the mistake, hit Revise and the channels will immediately go into write at the current fader level, allowing you to
overwrite the mistake.

JOIN FUNCTION

Will jump to roliback level when
Joinis pressed and write new
- data p

Start Press the Join Key | Rollback Point

New Automation
0ld Automation

Figure 16 - Join Function
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REVISE FUNCTION

Will stay at current mix level when
Revise is pressed and write new
data

Start Press the Revise Key | Roliback Point

New Automation
0Old Automation

Figure 17 - Revise Function

Multiple Rollback memories are supported so that successive operations of Join or Revise return different sets of
faders back to the write state, if multiple Rollback operations have taken place.

Mix Review Mix Running

ROLLBACK Glohal
Point 1 Roliback
Point

[

I
ROLLBACK |
[
I
i Time
I
[
Il
[
[
I

Paint 2

JOIN

Pass 1 (All Channels in
Absolute)

]
i
]
|
1
]
i
I
L
i
]
i
- | Pass 2 (Ch 1.8 in
| ! Absolute)

i I

| I

| pass 3 (Channels 7-8 in
| Absolute)
]

———! pPass 4

Figure 18 - Multiple Rollbacks

Here’s an example to make it a little clearer!

* Set up a new mix.

* Press play and automate all channels for about 20 seconds.
* Press stop.

* Rollback to the beginning of the track.

* Press play and automate channels 1-6 for about 15 seconds.
* Press stop.

* Rollback to the beginning of the track.

* Press play and automate channels 7-8 for about 10 seconds.

* Press stop.
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* Now play through the track and watch the fader status switches light up. After 10 seconds channels 7-8 will light
red, going back into write, after 15 seconds channels 1-6 will light red , going back into write, and after 20 seconds
all faders will light red, returning all remaining faders to write. See diagram below.

Time

=TI
=TI IHTITT

® Indicates channel in write

Figure 19 - Rollback sequence

* Rollback to the beginning of the track.

* Press Join (See diagram below) and all faders will light red and go into write from their individual last positions
before each rollback sequence, or press Revise (see diagram below) and all faders will start writing from current
position.

Press for all faders to Press for all faders to

start writing from start writing from
current position position before rollback

Figure 20 - Join and Revise on console.
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TRIM

Trim is a great method for updating fader data from the previous Mix Pass. Trim mode originates from VCA (non-
moving fader) automation systems and uses the fader to add or subtract from the existing moves. It achieves this
by setting up a 'null’ fader position and then any subsequent moves trim the existing data by the amount of
positive or negative change from the null point. Trim is useful, for example, when you have a complex automated
vocal line which needs raising by 2dB. Rather than trying to re-write the complex moves, here’s how you can do
it with Trim!

* You have just completed a great mix, but it is just that little bit too low! Before you panic and think you have to
redo it all, try this out!

* Rollback.
* Press the Trim soft key (see picture below).

Misc TR Auto § Lnks SsL

Trim Moff | TLock § Snap AT Match § Play cs

Trim key
Figure 21 - Trim key

* Set the value up by 2dB, indicated in the scribble strip above the fader.
* Press Play.

* Locate to the end of the Mix Pass.

* Press Stop.

* Press the End soft key to write over the original automation level - this will add the original automation and the
trim level, i.e. original +2dB.

New Automation

2dB
Increase

T

odB
Reference Value

Original
Automation

Figure 22 - Trim data.
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TRIM WITH MOTORS OFF

Trim can be used with fader motors On or Off. The previous example was with Motors On, where the null point
will be the fader position prior to selecting the trim auto switch or touching the fader. When in Motors Off (Moff),
the fader can be positioned at a suitable reference point on the scale before entering the Trim update status by
pressing the fader status switch. This can be useful, for example, if you want to set all faders to the mid position
of the fader track so when trimming, it is easy to visualise which have been trimmed up or down. Here’s how!

* After a first mix, the faders will probably be at different levels, so it can be tricky to see whether you are trimming
up or down!

* So simply Rollback, and press Trim and Moff (see figure below).

Misc TR Auto Lnks SSL

Trim key Moff Key
Figure 23 - Trim and Moff

* Set all the faders to their centre position along the fader track (see figure below).

MHHIINHONT

First mix, with faders at different levels

=T

fader track and press the fader status switch to
put intoe Trim, shown by the green LED

Figure 24 - Set fader positions

* Press all the fader status keys next to the fader so that the LED lights green.

* Now you can press play and move the faders to desired Trim level, and the values will be displayed on the
scribble strip above the fader.

* When you have finished trimming, press the End soft key to overwrite the original automation, adding the value
of the trim and original levels together.
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TRIM WITH TLOCK

AWSomation features SSL’s 'auto-nulling’ feature so that each time Trim is re-enabled a new null point is set.
TLock - Trim Lock - defeats the auto-nulling feature of the standard Trim function and ’locks’ the null point to the
position that the fader was in when Trim was first enabled in the current Mix Pass. This enables a defined trim
offset to be repeatedly punched in and out throughout the subsequent Mix Pass. Deselecting TLock clears an
stored null points.

An example of TLock would be bringing up the levels of guitar licks in a track. If for example Trim is used in Snap
Mode (see later in the AWSomation tutorials), the fader can be raised and let go repeatedly, returning to the
previous level. However it is difficult to have an identical increase in level each time when using manually (see
diagram below).

Fader released

“‘“‘;j““‘/‘i‘““j“““){““‘“#i!?:"“'

Fader moved

Figure 25 - Trim in Snap mode

Here is how we can use TLock to achieve better results:
* Rollback to the beginning.
* Press the Trim, Moff and TLock soft keys (see diagram below).

Trim key Moff Key TLock Key
Figure 26 - Trim, Moff and TLock soft keys

* Set the null point to a convenient level.

* Press the fader status switch and move the fader to the trim level you want the track to jump to, it will light green
when pressed.

* Press the fader status switch again to deactivate the trim level.

* Press play and then whenever you want to increase the level, press the fader status switch. Press again to
deactivate. If you want to change the level of the trim, simply move the fader and repeat the process.

* Now you will have no glide times, and the values will be identical (see diagram below).

Status key pressed again

—_—— - ___—H———-”———H —————— Lewvel is exact

Status key pressed

Figure 27 - Trim and TLock
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SNAP MODE

Snap mode uses the fader touch sensor to control both the start and end of a fader update for fast hands on
changes to mix levels. When the fader is released it ramps back to the previous mix level at a user determined
rate, then returns to replay.

* To activate, simply press the Snap soft key (see diagram below).

Misc TR Auto Lnks SSL

Figure 28 - Snap key

* Play through the track and when ever you want to change a level, touch the fader and move it to the desired
levels.

* When you let go it will jump to back to the original automation level, at a glide time dependant on what you set
up in the setup menu - to change the glide time value, end your Mix Pass, deselect the List Mix Key and press
the Setup key. Scroll to the Glide frames option and select using the D-Pot push switch. The values range from
0 (no glide) to 255 (10 second glide), selected by turning the D-Pot to the correct value and pressing the push
switch again. (see diagram of Setup Menu below)

00:02:12:23 Mix Enabled

| Glide frames: 10
Rollback Threshold frames: 5
Latched Match and Play: No

m-m----

Trim Moff § TLock § Snap AT Match § Play

Figure 29 - Setup menu
* This process can be repeated throughout the track. Press the End key to finish the Mix Pass.

New automation while helding
on to the fader

Glide time
in setup
menu

Original autemation

Figure 30 - Snap automation
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AUTOTAKEOVER MODE

To avoid a level jump when dropping out of write, AutoTakeover introduces nulling indicators in the scribble strip
to display the direction to move the fader to match the underlying mix level. When the fader crosses the current
mix level, it is automatically returned to replay and disconnected from the audio gain element. The fader returns
to following the mix data as soon as it is physically released.

* To activate, simply press the AT (AutoTakeover) soft key (see diagram below).

Misc TR Auto § Lnks SSL

Trim Moff §| TLock § Snap AT Match § Play Cs

/

AutoTakeover key

Figure 31 - AutoTakeover key

* Play through the track and when ever you want to change a level, touch the fader and move it to the desired
levels.

* When you have finished, let go of the fader, press the fader status key next to the fader, and the scribble strip
will show arrows indicating which way to move the fader. Move the fader in the correct direction, and when you
reach the original level, it will drop out of write (see diagram below).
* This process can be repeated throughout the track. Press the End key to finish the Mix Pass.

Scribble strip indicates

which way to move the
fader

New Automation

N

End point

/

Manually move

/

Start point

\

Original Automation
Figure 32 - AutoTakeover automation
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CuT AUTOMATION

Pressing a cut switch will toggle it's state and automatically start writing data. It can be returned to replay either
by rolling back or by selecting the soft Play key, then pressing the cut switch.

The state of the channel Cut switch is stored separately from the fader data. Cut data is stored regardless of the
current fader status unless channel Safe mode is selected. Whenever the Cut switch is in write, a ™ symbol is
displayed in the scribble strip above the fader.

Editing Cuts

* If you have made a mistake with a cut, and don’t want to have to redo it all, then don’t panic, here is the solution
with Match and Play!

*For example, you want to get rid of the first cut in the diagram below:

Press Press Press Press
Cut Cut Cut Cut

UNCUT:

cuT \

We don't want this one!

Figure 33 -Cut Error

* Before the first cut press the Match soft key (see figure 34) followed by the cut key. This will put it into write,
deleting the cut.

*When the cut is over, press the Play soft key (see figure 34) followed by the cut key. This will put it into replay
and will carry on as it was (see figure 35).

Match Play

key key
Figure 34 -Match and Play
Press the Match key Press the Play key
and the Cut key and the Cut Key

N N
Fa N

Figure 35 -Match and Play changes

* Match and Play are automatically deselected after each operation, unless the Latching option is enabled in the
Setup Menu (see Snap tutorial for location of Setup menu).
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